THE
MIRACLE
Piano Teaching
System Software

MACINTOSH® USER’S GUIDE

Copyright © 1990-1995 Mindscape, Inc.
All Rights Reserved.
# Table Of Contents

- **Getting Started** .............................................. 1
- **Quick Start Card** ........................................... 1
- **Connecting Your MIDI Keyboard** .......................... 1
- **Installing The Miracle** ..................................... 2
- **Launching The Miracle** ..................................... 3
- **Enrolling In The Miracle** ................................... 4
- **The Miracle Conservatory** ................................. 7
  - **Conservatory Menus** .................................... 8
  - **Online Help** ............................................... 10
  - **Online Glossary** ......................................... 11
  - **Note Reference** .......................................... 12
- **Using The Software** ......................................... 13
  - **Administration** .......................................... 14
  - **Classroom** ................................................. 17
  - **Practice Room** ........................................... 20
  - **Performance Hall** ........................................ 23
  - **Arcade** ................................................... 25
  - **Studio** .................................................. 29
- **The Theory Behind The Miracle** .......................... 35
- **Getting The Most From The Miracle** ..................... 39
  - **Practice Makes Perfect** ................................ 40
  - **Special Note To Teachers** ................................ 41
  - **Note To Experienced Players** ............................ 42
CREDITS

The Miracle Piano Teaching System

Project Manager .............................................. David Rudolph
Piano Method .................................................. Roy Bogas

Software Development ........................................... Esteban Ahn
.................................................................................... Scott Daley
.................................................................................... Don Laabs
.................................................................................... Bryan Lerda
.................................................................................... Walt Bilofsky
.................................................................................... Jeff Chace
.................................................................................... Mike Collins
.................................................................................... Michael Duffy
.................................................................................... Richard Shureim
.................................................................................... Rick Glen
.................................................................................... David Grenewatzki
.................................................................................... Troy Heere
.................................................................................... Jon Mandel
.................................................................................... Pat McCarthy
.................................................................................... Marc Roegiers

Additional Development and MIDI Patch Maps .......... Ron Wagner

Music Design ..................................................... Rob Wallace
.................................................................................... Scott Daley

Music Transcription ............................................. Tara Patterson
.................................................................................... William Todd

Testing ................................................................. Lisa von Derwies, Roman Bahiaik: Leads
.................................................................................... Jason Burwick, Nikos Page

Artwork ............................................................... Vicki Sidley
.................................................................................... Tanya Brooks
.................................................................................... Vicky Fink
.................................................................................... Richard Payne
.................................................................................... Katherine Thornton
.................................................................................... Erica Benson
.................................................................................... Jeff Griffith
.................................................................................... Bruce Krueger
.................................................................................... Gene Hanna

Senior Vice President, Home/Kids ......................... Joan Ziegler

Executive Producer ............................................. James Haldy

Marketing Coordinator ....................................... Kirsten Brengle

Documentation

Technical Writer .................................................. Anne O'Brien
Graphic Artist .................................................... Darilyn Kotzenberg
Copyrights


Manual Copyright © 1990-1995 Mindscape, Inc. All rights reserved.

Mindscape is a registered trademark and the Mindscape logo is a trademark of Mindscape, Inc. The Miracle and the Miracle Piano Teaching System are trademarks of Creative Insights, Inc. USED UNDER LICENSE.

Macintosh® is a registered trademark and PowerBook, QuickDraw, and Balloon Help are trademarks of Apple Computer, Inc.

PostScript® is a registered trademark of Adobe Systems Incorporated.

United States Patent No. 4,365,533 under license from REFAC International, Ltd.

This program is licensed for use only in accordance with the accompanying License Agreement and Limited Warranty included with the software. PLEASE READ THE LICENSE AGREEMENT AND LIMITED WARRANTY CAREFULLY BEFORE USING THIS SOFTWARE.

No part of this manual may be reproduced in any manner whatsoever without the written permission of Mindscape, Inc. Except as specifically provided in the License Agreement, you may not reproduce this software without the written permission of Mindscape, Inc.

WARNING: THE MUSIC INCLUDED IN THIS PROGRAM IS INTENDED FOR PRIVATE USE. PUBLIC PERFORMANCES OR OTHER USE IS EXPRESSLY PROHIBITED. IT IS A VIOLATION OF FEDERAL COPYRIGHT LAW TO SYNCHRONIZE THE MUSIC CONTAINED IN THE MIRACLE PIANO TEACHING SYSTEM SOFTWARE WITH VIDEO TAPE OR FILM, OR TO PRINT THE MUSIC CONTAINED IN THE MIRACLE PIANO TEACHING SYSTEM SOFTWARE IN THE FORM OF STANDARD MUSIC NOTATION WITHOUT THE EXPRESS WRITTEN PERMISSION OF THE COPYRIGHT OWNER.
MACINTOSH SONG COPYRIGHTS

The following music is used with permission:

_A Summer Place_
(Max Steiner, Mack Discant)
© 1959 (Renewed) Warner Bros. Inc.
All Rights Reserved. Used By Permission.

_And I Love Her_
(John Lennon, Paul McCartney)
© 1964 Northern Songs. All Rights Controlled and Administered by MCA Music Publishing.
A Division of MCA Inc., New York, NY 10019, under license from Northern Songs.
All Rights Reserved. Used By Permission. International Copyright Secured.

_And The Angels Sing_
(Ziggy Elman, Johnny Mercer)
© 1939 WB Music Corp. (Renewed)
All Rights Reserved. Used By Permission.

_Can You Read My Mind_
(John Williams, Leslie Bricusse)
All Rights Reserved. Used By Permission.

_Chariots of Fire_
(Vangelis)
© 1981 Spheric B.V. (BUMA)
All Rights on behalf of Spheric B.V. for the world excluding the Netherlands Administered by WB Music Corp.
All Rights Reserved. Used By Permission.

_Don't Be Cruel_
(Oris Blackwell, Elvis Presley)
© 1965 Elvis Presley Music
All Rights on behalf of Elvis Presley Music Administered by Unichappell Music Inc.
All Rights Reserved. Used By Permission.

_Evergreen_
(Barbara Streisand, Paul Williams)
© 1976 WB Music Corp., Emmanuel Music Corp. & First Artists Music Co.
All Rights Administered by WB Music Corp.
All Rights Reserved. Used By Permission.

_Fools Rush In_
(Rube Bloom, Johnny Mercer)
© 1940 WB Music Corp. (Renewed)
All Rights Reserved. Used By Permission.

_Happy Birthday to You_
(Mildred J. Hill, Patty S. Hill)
© 1935 (Renewed)
Summy-Birchard Music,
A Division of Summy-Birchard, Inc.
All Rights Reserved. Used By Permission.
Here, There, & Everywhere
(John Lennon, Paul McCartney)
© 1966 Northern Songs. All Rights Controlled and
Administered by MCA Music Publishing,
A Division of MCA Inc., New York, NY 10019, under license
from Northern Songs.
All Rights Reserved. Used By Permission. International
Copyright Secured.

Love Me Tender
(Elvis Presley, Vera Matson)
© 1956 Elvis Presley Music (Renewed)
All Rights Administered by Unichappell Music Inc.
All Rights Reserved. Used By Permission.

Mack The Knife
(Kurt Weill, Bert Brecht, Marc Blitzstein)
© 1928 Universal Edition (Renewed)
All Rights for the U.S. & Canada
Administered by WB Music Corp.
All Rights Reserved. Used By Permission.

Many Monday
(Christopher)
© 1964 Controversy Music
All Rights on behalf of Controversy Music for the
U.S.A. & Canada only Administered by WB Music Corp.
All Rights Reserved. Used By Permission.

Michelle
(John Lennon, Paul McCartney)
© 1965 Northern Songs. All Rights Controlled and
Administered by MCA Music Publishing,
A Division of MCA Inc., New York, NY 10019, under license
from Northern Songs.
All Rights Reserved. Used By Permission. International
Copyright Secured.

Moondance
(Van Morrison)
© 1971 WB Music Corp. &
Caledonia Soul Music
All Rights Administered by WB Music Corp.
All Rights Reserved. Used By Permission.

Mr. Bojangles
(Jerry Jeff Walker)
All Rights on behalf of Cotillion Music, Inc.
Administered by Warner-Tamerlane Publishing Corp.
All Rights Reserved. Used By Permission.

Mr. Tambourine Man
(Bob Dylan)
© 1964 Warner Bros. Inc.
All Rights Reserved. Used By Permission.
Norwegian Wood
(John Lennon, Paul McCartney)
© 1965 Northern Songs. All Rights Controlled and
Administered by MCA Music Publishing,
A Division of MCA Inc., New York, NY 10019, under license
from Northern Songs.
All Rights Reserved. Used By Permission. International
Copyright Secured.

Puff (The Magic Dragon)
(Peter Yarrow, Leonard Lipton)
© 1963 Pepamar Music Corp.
All Rights Reserved. Used By Permission.

Stand By Me
(Ben E. King, Mike Stoller, Jerry Leiber)
© 1961 by Leiber-Stoller Songs, Inc., and
Unichappell Music Inc. (Copyright Renewed)
All Rights Reserved. Used By Permission.

Star Wars
(John Williams)
& Bantha Music. All Rights Administered by
Warner-Tamerlane Publishing Corp.
All Rights Reserved. Used By Permission.

 Tea For Two
(Vincent Youman, Irving Caesar)
© 1924 WB Music Corp. (Renewed)
& Irving Caesar Music Corp.
All Rights Administered by WB Music Corp.
All Rights Reserved. Used By Permission.

Theme from M*A*S*H
(Johnny Mandel, Michael Altman)
© 1984 WB Music Corp.
All Rights Reserved. Used By Permission.

The Rose
(Amanda McBroom)
© 1979 Warner-Tamerlane Publishing Corp. &
Third Story Music Inc.
All Rights Reserved. Used By Permission.

We Are The World
(Michael Jackson, Lionel Richie)
© 1985 MJJAC Music & Brockman Music
All Rights on behalf of MJJAC Music Administered by
Warner-Tamerlane Publishing Corp. & All Rights on
behalf of Brockman Music Administered by WB Music Corp.
All Rights Reserved. Used By Permission.

Yellow Submarine
(John Lennon, Paul McCartney)
© 1966 Northern Songs. All Rights Controlled and
Administered by MCA Music Publishing,
A Division of MCA Inc., New York, NY 10019, under license
from Northern Songs.
All Rights Reserved. Used By Permission. International
Copyright Secured.
Yesterday
(John Lennon, Paul McCartney)
© 1965 Northern Songs. All Rights Controlled and
Administered by MCA Music Publishing,
A Division of MCA Inc., New York, NY 10019, under license
from Northern Songs.
All Rights Reserved. Used By Permission. International
Copyright Secured.

You're Sixteen
(Bob Sherman, Dick Sherman)
© 1960 Warner-Tamerlane Publishing Corp. (Renewed)
All Rights Reserved. Used By Permission.

You've Got To Hide Your Love Away
(John Lennon, Paul McCartney)
© 1965 Northern Songs. All Rights Controlled and
Administered by MCA Music Publishing,
A Division of MCA Inc., New York, NY 10019, under license
from Northern Songs.
All Rights Reserved. Used By Permission. International
Copyright Secured.

Warning: The music included in this program is intended
for private use. Public performances or other use is
expressly prohibited. It is a violation of federal copyright
law to synchronize the music contained in The Miracle
Piano Teaching System with video tape or film, or to print
the music contained in The Miracle Piano Teaching System
in the form of standard music notation without the express
written permission of the copyright owner.
GETTING STARTED

Have you always wanted to learn how to play the piano? The Miracle® Piano Teaching System with your Macintosh® and MIDI piano keyboard can help you do it!

Quick Start Card

The Miracle runs with various Macintosh computers and MIDI keyboards. See the Quick Start Card for system requirements and any special installation instructions that apply to your version of the program. That card also lists The Miracle Technical Support offices. For general installation instructions, see Installing The Miracle in this section. For general information about The Miracle and the Macintosh, see Macintosh Conventions at the end of this manual.

Caution: Please don't run a screen saver with The Miracle, or you may suddenly shut down and lose student records for the current session. See the Miracle Read Me file in the Miracle folder on your hard drive to learn about any other cautions that apply to your version of software.

Connecting Your MIDI Keyboard

The Miracle is designed to run with most General MIDI keyboards. Refer to your General MIDI keyboard owner's manual and the system requirements on The Miracle Quick Start Card to determine whether your MIDI keyboard will work.

Before attempting to install or run The Miracle software, please make sure your MIDI keyboard is connected to your Macintosh MIDI adapter, and is turned on. Make sure the MIDI out cable is plugged into the MIDI in of the piano and the MIDI in cable is plugged into the MIDI out of the piano. You must also have the Apple MIDI Manager installed as an active extension in your Macintosh System Folder (the install program automatically loads this).
Installing The Miracle

To install The Miracle on your Macintosh's hard disk drive:

1. Connect and turn on your MIDI keyboard (see Connecting Your MIDI Keyboard).
2. Turn on your Macintosh.
3. Insert Miracle Disk #1 into your floppy drive.
4. Open the disk by double-clicking it (if it is not already open).
5. Double-click the Installer to run it.
6. Click the Install button.
7. During installation, the Installer prompts you to insert disks as needed.
8. At the end of installation, the Installer prompts you to click the Restart button.

Once installation is complete and the Macintosh restarts, the Miracle program icon appears in the Miracle folder on your hard drive (or wherever you choose to put it). You can drag this icon to your Desktop, or use the File menu Make Alias and add it to the Apple menu in your System Folder.
LAUNCHING THE MIRACLE

To launch the program:

1. Double-click the Miracle program icon in the Miracle folder (or on your desktop if you dragged it there).

2. If your monitor settings are not at an optimum, the Miracle Monitors dialog box may appear. Click Change or Run to choose a monitor color setting.

3. The Miracle title screen appears. You can listen to the song or click to interrupt it.

4. The Open Student dialog box appears.

5. Choose a command button as follows:

   - **New Student** - Enroll in The Miracle Piano Teaching System, so you can track your progress. See Enrolling in The Miracle.

   - **Browse** - Open the Welcome dialog box and choose Begin Lesson or Conservatory.

   - **Quit** - Exits the program and returns to the Desktop.

*Note: After you enroll, the Open Student dialog box lists your name and changes the Browse button to OK. You can then either select Browse OR your name from the list and choose OK to open the Welcome dialog box (shown in Enrolling in The Miracle below).*
ENROLLING IN THE MIRACLE

If you are a brand new student, enroll in The Miracle as follows:

1. On the Open Student dialog box, choose the New Student command button.

The New Student dialog box appears.

2. Type your Full name and press Tab; type your Nickname and press Tab; type your Birthdate in MM DD YY format and click OK.

3. The Open Student dialog box reappears. Select your name and click OK.
The Welcome dialog box appears.

4. Choose a command button as shown:

- **Begin Lesson** - Go to your Lesson. (After you complete the first Lesson, this command button changes to **Resume Lesson**. See Classroom in Using the Software.)

- **Conservatory** - Go to the main menu. See *The Miracle Conservatory*. 
The Miracle main menu is the Miracle Conservatory.

In the Miracle Conservatory, software functions are organized into the following six rooms. The chapter *Using the Software* offers specific instructions for each of the rooms by name, including:

- **Administration** - Edit or delete students, set system features (metronome volume, MIDI patch maps), and check your progress.

- **Classroom** - Go to a specific Chapter or resume your current Lesson.

- **Arcade** - Play arcade-style games or the Jukebox.

- **Studio** - Record and play back your own performances.
- Performance Hall - Play with The Miracle Orchestra.

- Practice Room - Pick your practice mode, such as practice notes or practice rhythms.

Click any room to open its dialog box of commands, or open its dialog box from the Conservatory Go to menu.

To return to the Conservatory from any room, choose Conservatory from the Go to menu or press "K.

You can also get online help from the Help and " menus. See Online Help.

**Conservatory Menus**

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Go to</th>
<th>Help</th>
</tr>
</thead>
</table>

Click to open the pull-down and drag to choose commands. For some commands, you can press the command key (K) and the indicated letter without pulling down the menu. See *Macintosh Conventions* at the end of this manual.

*Note:* The Edit menu is only active when you are typing Student information, such as your name. See *Administration* in *Using the Software*.

The Conservatory menu bar includes the active menus and commands shown on the chart.
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Student</td>
<td>F</td>
</tr>
<tr>
<td>Open Student</td>
<td>F</td>
</tr>
<tr>
<td>Close Student</td>
<td>W</td>
</tr>
<tr>
<td>Page Setup...</td>
<td></td>
</tr>
<tr>
<td>Print Certificates</td>
<td>P</td>
</tr>
<tr>
<td>Quit</td>
<td>Q</td>
</tr>
<tr>
<td>Classroom</td>
<td>G</td>
</tr>
<tr>
<td>Go to Chapter...</td>
<td>C</td>
</tr>
<tr>
<td>Restart Lesson</td>
<td>R</td>
</tr>
<tr>
<td>Arcade</td>
<td></td>
</tr>
<tr>
<td>Ducks</td>
<td>B</td>
</tr>
<tr>
<td>Ripperf</td>
<td>I</td>
</tr>
<tr>
<td>Allies</td>
<td>A</td>
</tr>
<tr>
<td>Jukebox</td>
<td>J</td>
</tr>
<tr>
<td>Administration</td>
<td></td>
</tr>
<tr>
<td>Patch Setup...</td>
<td>P</td>
</tr>
<tr>
<td>Student...</td>
<td>S</td>
</tr>
<tr>
<td>Miracle Setup...</td>
<td>M</td>
</tr>
<tr>
<td>Hall of Fame</td>
<td>H</td>
</tr>
<tr>
<td>Practice Progress...</td>
<td>P</td>
</tr>
<tr>
<td>Lesson Chart...</td>
<td>L</td>
</tr>
<tr>
<td>Performance Hall</td>
<td></td>
</tr>
<tr>
<td>Practice Room</td>
<td></td>
</tr>
<tr>
<td>Demo</td>
<td>D</td>
</tr>
<tr>
<td>Solo</td>
<td>S</td>
</tr>
<tr>
<td>Duet</td>
<td>U</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Rhythms</td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td></td>
</tr>
<tr>
<td>Show/Hide Help</td>
<td>R</td>
</tr>
<tr>
<td>Glossary</td>
<td></td>
</tr>
<tr>
<td>Note Reference</td>
<td></td>
</tr>
<tr>
<td>Balloon Help</td>
<td></td>
</tr>
<tr>
<td>Show/Hide Balloons</td>
<td></td>
</tr>
</tbody>
</table>
**Online Help**

In the Conservatory, online help is available from the Help and menu menus on the menu bar.

**The Miracle Help**

To use The Miracle floating window help:

1. Choose Show Help on the Help menu, or press \[\text{F1}\].

The floating Help window appears. You can click and drag on the title bar to move this window anywhere you want on your screen.

2. Move the mouse and point at buttons, windows, or other areas, then read the description in the floating window.

3. To exit online help, choose Hide Help on the Help menu, or press \[\text{F1}\].

*Note:* You can also click the close box in the upper left corner of the floating window.

**Balloon Help**

To use Macintosh Balloon Help (available with System 7.0 or higher):

1. Choose Show Balloons on the menu.

2. Move the mouse and point at buttons, windows, or other areas, then read the description in the floating window.

3. Choose Hide Balloons on the menu to turn Balloon Help off.
Online Glossary

The Help menu has a Glossary command, which lets you look up definitions of musical terms used in The Miracle.

To use the Glossary:


2. On the left side of the screen, scroll to select a term.

3. To view a definition, double-click a term, or click OK, or press Return.

4. Click Cancel or press Esc to return to the Conservatory.
Note Reference

Note Reference is a handy feature for serious students of the piano who need to learn more about notes, key signatures, scales, and arpeggios. This feature is particularly useful if you are interested in transposing music into a key other than the one in which it was written.

To use Note Reference:

1. Choose Note Reference on the Help menu. The Note Reference dialog box appears.

   ![Note Reference Dialog Box]

2. The program defaults to the Note button. Click Single or Octaves then press a note on your General MIDI keyboard, such as C. The note you press appears onscreen in the long display box above the buttons and is also highlighted on the staff at the top part of the screen. (As shown in the example above.)

3. Click Key if you want to Hide or Show the key signature. If you choose Show, then you can select and view the note spellings for the Major or Minor key signature. For example, you see “C Major” if you press a C on the keyboard or “F Major” if you press an F, and so on.

4. You can also click Pattern, and set Scale or Arpeggio (a chord breakdown) and Major or Minor.

5. Choose OK to close the dialog box, or choose Reset and OK to restore the original default settings before closing.
Using the Software

This chapter explains how to use each of the six rooms that you can go to from The Miracle Conservatory.

Click any room to open its dialog box of commands, or open its dialog box from the Conservatory Go to menu.

To return to the Conservatory from any room, choose Conservatory from the Go to menu or press &K.

You can also get online help from the Help and & menus.
When you choose **Administration** in the Conservatory or from its Go to menu, you open the **Administration** dialog box.

From here, you can edit or delete student records, view your progress, and set up various system features such as keyboard and metronome volume. Click Cancel or press Esc to return to the Conservatory or choose one of the command buttons shown below.

To get online help in Administration, choose **Show Help** from the Help menu, or press F1, or choose **Show Balloons** from the F menu.

The **Student** command opens the **Edit Student** dialog box. From here you can browse The Miracle, edit a student record, or delete a record.

To delete an existing student record, select the name and choose the **Delete Student** command. The name disappears from the screen and the track record for that name is erased. (You may want to back up before deleting, if you want to save progress tracking records.)

To change an existing student record, select the name; and choose the **Edit Student** command. The **Edit Student** dialog box opens, where you can type corrections; and choose **OK**.

*Note:* To add a new student, choose **New Student** on the File menu. For instructions on adding a new student record, see *Enrolling in The Miracle in Getting Started.*
The Miracle Setup command opens the Miracle Setup dialog box.

View or change system default settings as shown below. Choose OK to confirm the changes, Reset to restore the system defaults, or Cancel to exit without changing the setup.

Page Turn - Use this drop-down field to set the automatic page turning feature for sheet music. Next to Measures Anticipated, accept the default: 1/2, or click and drag to set the page turn to None, 1, 1 1/2, or 2 half measures before the end of the page. This will affect page turns in the Classroom, Performance Hall, and Practice Room.

Practice Room & Performance Hall Evaluations - Click this check box to turn progress evaluations in the Practice Room and Performance Hall on and off. An X in the box means that evaluations are on (default).
Note: Evaluations are always on in the Classroom.

Fade Transitions - Click this check to turn fade transitions on and off. An X in the box means that fading is on (default) and screens will slowly black out as you move to another room.

Note: To speed up program performance, turn Fade Transitions off by clearing the check box. If you are in Black & White mode, this button will not appear.

Reset - Click the Reset button to restore the factory default settings for page turn, evaluation, foot pedal, and volumes.

The Hall of Fame command opens the Hall of Fame dialog box. Click one of the Game buttons: (Ducks, Ripchord, or Aliens) to see the top ten scores for that game by student name and song. Use the scroll bar to see additional names, songs, or scores, as needed. Choose OK to return to the Conservatory.
The Practice Progress command opens the Practice Progress dialog box. Click one of the Display buttons, Bar Graph or Pie Charts, to view analysis of your most recent overall performance, notes, and rhythm by song. Scroll to view more song names as needed. The Legend shows the color or patterns for Song, Notes, and Rhythm on your Macintosh graph or chart display. Choose OK to return to the Conservatory.

The Lesson Chart command opens the Lesson Chart dialog box, where you can see the Lessons you've started and completed for each Chapter. Click and drag the scroll bars to view more Chapters and/or more Lessons. Position the cursor over a Lesson to see the selected Chapter name, such as Chapter 4 - Twinkle Twinkle. Click OK to return to the Conservatory.

Set up or restore the Patch Map for your MIDI keyboard. You can also use this feature to remap from one instrument voice to another. For example, you can get the program to sound like a fuzz guitar instead of a harpsichord. For details on setting or remapping instrument patches for your version of the program, see your Quick Start Card.

Administration Edit Menu

The Edit menu is only active when you add or edit a student record. When active, the commands are compatible with other Macintosh applications. Undo is not an active command in this program.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
</tr>
<tr>
<td>Clear</td>
<td></td>
</tr>
</tbody>
</table>

* Z: Toggle highlighting text.
* M: Copy highlighted text.
* C: Paste highlighted text.
* U: Clear the currently selected field.
Classroom

The Miracle Classroom is where you will spend most of your time learning to play the piano. In the Classroom, you can select from 40 different Chapters. Each Chapter has multiple Lessons organized around learning a particular song. A Lesson usually involves a series of instructional Chalkboards, demonstrations, and practices. For a change of pace, some Lessons send you to the Arcade to play games. The end of every Lesson sends you to the Performance Hall to play with The Miracle Orchestra. And sometimes, but not often, you will get a pop quiz! Some Chalkboards include highlighted Glossary words. To study a Glossary word, double-click it. See Glossary in The Miracle Conservatory.

You can go to the Classroom three ways:

- Click the Classroom in the Conservatory. See the following step-by-step instructions.

- Choose the Begin Lesson or Resume Lesson command on the Welcome screen. Same as step 2 below.

- Choose a Classroom command from the Conservatory Go to menu.

To exit the Classroom and return to the Conservatory, choose Conservatory from the Go to menu or press $K$.

To get online help in the Classroom, choose Show Help from the Help menu, or press $H$, or choose Show Balloons from the $ HELP $ menu. See Online Help in Getting Started.

To use the Classroom:

1. Starting from the Conservatory, click the Classroom.
2. Click one of these icons:

**Go to Chapter** - Select from the 40 Chapters in *The Miracle*. In the **Go to Chapter** dialog box, scroll to select a Chapter, then click OK or press Return.

**Resume Lesson** - Return to the Lesson where you left off last time.

3. Each Chapter presents a series of Chalkboards, demonstrations, and practice Lessons. To go to the next Chalkboard, simply play the piano as instructed or click the available command button, which can be:

**Turn to the next Chalkboard Lesson.**

**Listen to The Miracle demonstrate the piece.**

**Play the piece as shown on screen.**

**Go to an Arcade Lesson. See also Arcade.**

4. During a few Lessons, pop quizzes test your understanding of what you've learned. All questions are multiple choice. To answer a question, click the answer button (1, 2, 3, or 4). If you answer incorrectly, *The Miracle* tells you to try again. To try again, click OK or press Return.
# Classroom Menus

The Classroom menu bar includes the menus and active commands shown below. You can open all the menus and choose commands with the mouse. For some commands, you can press the command key (⌘) and the indicated letter without pulling down the menu. ⌘

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About the Miracle...</td>
<td></td>
<td>Get information about our version of the program and collect resources in your system for easy application.</td>
</tr>
<tr>
<td>File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quit</td>
<td>⌘Q</td>
<td>Exit the Miracle and return to the desktop.</td>
</tr>
<tr>
<td>Go to</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conservatory</td>
<td>⌘K</td>
<td>Go to the Conservatory</td>
</tr>
<tr>
<td>Help</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show / Hide Help</td>
<td>⌘H</td>
<td>Turn on / off help on and off.</td>
</tr>
<tr>
<td>Lesson</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Next Lesson</td>
<td>⌘1</td>
<td>Go to the next lesson in series.</td>
</tr>
<tr>
<td>Previous Lesson</td>
<td>⌘L</td>
<td>Go to the previous lesson in a series.</td>
</tr>
<tr>
<td>Restart Lesson</td>
<td>⌘R</td>
<td>Go to the beginning of the current lesson.</td>
</tr>
<tr>
<td>Balloon Help</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show / Hide Balloons</td>
<td></td>
<td>Turn Balloon Help on and off.</td>
</tr>
</tbody>
</table>

*Note: Using the Next and Previous commands will move you to a new Lesson and not just skip the next activity in the current Lesson. For example, if you don't want to hear a demo and choose Next Lesson, the program will go to the next Lesson in the series and not just skip the demo.*
Practice Room

The Practice Room is where you can review materials presented in the Lessons or practice any of the pieces included in The Miracle. You should visit here often. Practice sharpens your skills so that you can tackle more advanced Lessons.

To go to the Practice Room from the Conservatory, click the room or select a practice mode on the Conservatory Go to menu.

To use the Practice Room:

1. Click the Practice Room or choose the command from the Conservatory Go to menu. A Choose a Song for Practice dialog box appears.

2. Accept the default Tempo or click the ▲ or ▼ buttons to decrease or increase the song speed.

3. Accept the default Hands, or click Left, Right, or both as available.

4. Accept the default for View By (which is Chapter Level), or click Name to view the songs by title.

5. If you have additional Song Collections loaded, use the drop-down Collection field to choose the set you want.
6. Scroll through the list to find the song you want. You can also type the first letter(s) of the name to jump to a list starting with the letter(s).

7. Click a song name then OK. The Practice dialog box appears.

8. Depending on the song and hands you selected, the Practice Room offers up to five practice modes:

   - **Demo** - You listen to The Miracle play.
   - **Solo** - You practice alone. You will hear the metronome.
   - **Duet** - You play one hand and The Miracle plays the other. If you selected both hands in step 3, The Miracle will not give you the option of playing a duet. Choose Cancel to go back to the Choose a Song for Practice dialog box and select either left or right hand.
   - **Practice Notes** - You practice the piece without a rhythm at your own pace.
   - **Practice Rhythms** - You can hit any key on the keyboard as long as you have the right rhythm. You will hear the metronome and the correct note will sound.
   - **Cancel** - Go back to the Choose a Song for Practice dialog box.

8. When the sheet music appears onscreen, wait for the lead beats then start to play. When the practice ends, you get an evaluation unless you turned it off in the Miracle Setup (see Administration).

9. Choose to continue... to return to the Practice dialog box.

To interrupt or end practice and return to the Conservatory, choose Conservatory from the Go to menu, or press $K$, or choose Cancel in the Choose a Song for Practice dialog box.
Practice Room Menus

The Practice Room menu bar includes the menus and commands shown below. You can open all the menus and choose commands with the mouse. For some commands, you can press the command key (%) and the indicated letter without pulling down the menu.

<table>
<thead>
<tr>
<th>File</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Quit</td>
<td>Ctrl-U</td>
</tr>
<tr>
<td></td>
<td>Ener The Miracle and return to the desktop.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Go to</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Conservatory</td>
<td>Ctrl-K</td>
</tr>
<tr>
<td></td>
<td>Return to the Conservatory.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Help</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/Hide Help</td>
<td>Ctrl-H</td>
</tr>
<tr>
<td></td>
<td>Turn Online Help on and off.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Balloon Help</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/Hide Balloons</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Turn Balloon Help on and off.</td>
</tr>
</tbody>
</table>

*Note: Online help is available while you choose a song; however, it is not available during practice.*
Performance Hall

The Performance Hall is where you go to play with The Miracle Orchestra.

To go to the Performance Hall from the Conservatory, click the room or use the Conservatory Go to menu.

To play with The Miracle Orchestra:

1. Click the Performance Hall or choose the command from the Conservatory Go to menu. A Choose a Song to Perform dialog box appears (see Practice Room for an example).

2. Accept the default Tempo or click the ▲ or ▼ buttons to decrease or increase the song speed.

3. Accept the default Hands, or click Left, Right, or both as available.

4. Accept the default View by, which is Chapter Level, or click Name to view the songs by title.

5. If you have additional Song Collections loaded, use the drop-down Collection field to choose the set you want.

6. Scroll through the list to find the song you want. You can also type the first letter(s) of the name to jump to a list starting with the letter(s).

7. Click a song name then OK.

8. When the sheet music appears onscreen, wait for the lead beats then start to play.

9. When the performance ends, you get an evaluation, unless you turned it off in the Miracle Setup (see Administration). Click To Continue to go to the Choose a song to Perform dialog box and pick another song to perform.
To interrupt or end performing and return to the Conservatory, choose Conservatory from the Go to menu, or press F11, or choose Cancel in the Choose a song dialog box.

Performance Hall Menus

The Performance Hall menu bar includes the menus and commands shown below. You can open all the menus and choose commands with the mouse. For some commands, you can press the command key (F) and the indicated letter without pulling down the menu.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quit</td>
<td>F11</td>
<td>Exit the Miracle icon to the desktop.</td>
</tr>
<tr>
<td>Go to</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conservatory</td>
<td>F6</td>
<td>Return to the Conservatory.</td>
</tr>
<tr>
<td>Help</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show/Hide Help</td>
<td>F5</td>
<td>Turn online help on and off.</td>
</tr>
<tr>
<td>Balloon Help</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show/Hide Balloons</td>
<td></td>
<td>Turn Balloon Help on and off.</td>
</tr>
</tbody>
</table>

Note: Online help is available while you choose a song; however, it is not available during a performance.
ARCADE

The Arcade is where you go to play practice games, including Ducks, Ripchord, and Aliens. You can also play the Jukebox from here.

To go to the Arcade from the Conservatory, click the room or select an Arcade command from the Go to menu.

To return to the Conservatory, choose Conservatory from the Arcade Go to menu, or press $K$.

To get help, choose Show Help on the Help menu, or Show Balloons on the $H$ menu.

The Arcade includes these options:

**Ducks** - This Shooting Gallery game helps you associate keys on your General MIDI keyboard with written notes on the staff. Ducks swim across the lines and spaces of the staff from right to left. Armed with paint bombs at the bottom, you must hit each duck by playing the note that it swims across. If you press the correct key, the duck disappears. If you press a wrong note, the paint splats against the wall. If a duck disappears off the screen unhit, a paint bomb is used up. The number of throws per duck varies from Lesson to Lesson.

*Note:* No matter how many ducks appear on the screen, your bombs can only hit the duck(s) that are farthest to the left.

**Ripchord** - This game is a fun way to practice chords. A helicopter appears pulling the chord you must play. The timer on the upper right of the screen shows you how many seconds you have to play the chord. Play the notes to send the parachutists on their way. Notes that are played correctly gray out on the staff in color systems. Play the wrong chord and — oops, the little men go splat!
Aliens - This game is a far out way to practice fingering and memorize note sequences. Wait for the Alien spaceship to descend, beam down the staff, and begin playing its notes. The next note to play is shown two ways: as a spotlight on the Alien keyboard and as a red triangle ▲ under notes on the staff. First the Aliens play, then you copy them. A red bar on the right side of the screen shows how much time you have to play. If you get enough notes right, you'll experience a close encounter!

Jukebox - You can use The Miracle Jukebox to play any song in the program with complete orchestral accompaniment and no metronome. See Playing the Jukebox.

Playing Arcade Games

To play an Arcade game:

1. Click the Arcade. The Arcade dialog box appears.

2. Click a game icon (Ducks, Ripcord or Aliens!). A Choose a Song dialog box appears (see Practice Room for an illustration of a similar dialog box).

3. Accept the default for Hands or click Left or Right as available.

4. Accept the default for View by, which is Level, or click Name to view songs in alphabetical order.

5. If you have additional Song Collections loaded, use the drop-down Collection field to choose the set you want.

6. Scroll to find the piece you want. You can also type the first letter(s) of the name to jump to a list starting with the letter(s).

7. To select a song, take one of these alternatives:

   • Double-click the song name.
   • Click the song name and OK.
   • Press ▲ or ▼ to select the song name, then press Return.

Note: To interrupt a game and return to the Conservatory, use the Go to menu or press 3* K.

To get help, choose Show Help from the Help menu, or press 3* H, or choose Show Balloons from the 3 menu.
Arcade Game Menus

The Arcade Game menu bar includes the active menus and active commands shown below. You can open all the menus and choose commands with the mouse. For some commands, you can press the command key (88) and the indicated letter without pulling down the menu.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td></td>
<td>Quit (Q) - Exit the Arcade and return to the desktop.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Do Ly (E) - Select a conservatory.</td>
</tr>
<tr>
<td>Help</td>
<td></td>
<td>Show/Hide Help (H) - Show or hide on and off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Balloon Help</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Show/Hide Balloons (B) - Show Balloon Help on and off.</td>
</tr>
</tbody>
</table>

*Note: Online help is available while you choose a song; however, it is not available during game play.*

Playing the Jukebox

To play the Jukebox:

1. Click the Arcade room. The Arcade dialog box appears.
2. Click the Jukebox icon. The Jukebox appears.
3. Click the buttons on the Jukebox to operate it as follows:

   - **Open** - A file dialog box opens. Choose a song folder from the drop-down Songs field at the top of the box. You can scroll to find the piece you want, or type the first letter(s) of the name to jump to a list starting with the letter(s). Double-click a song to open it.
   - **Play** - Listen to the currently open song.
   - **▲** - Increase the song volume.
   - **▼** - Decrease the song volume.
• **Stop** - Pause the currently open song. Press Play again to resume.

• **Quit** - Return to the Conservatory.

*Note:* You can also use the menu bar to operate the Jukebox. See *Jukebox Menus.*

To get help, choose Show Balloons from the \( \text{F} \) menu.

### Jukebox Menus

The Jukebox menu bar includes the active menus and active commands shown below. You can open all the menus and choose commands with the mouse. For some commands, you can press the command key (\( \text{Alt} \)) and the indicated letter without pulling down the menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open Song</strong></td>
<td>( \text{F} )0</td>
</tr>
<tr>
<td><strong>Overall Volume Up</strong></td>
<td>( \text{Alt} )1</td>
</tr>
<tr>
<td><strong>Overall Volume Down</strong></td>
<td>( \text{Alt} )1</td>
</tr>
<tr>
<td><strong>Tempo Up</strong></td>
<td>( \text{Alt} )2</td>
</tr>
<tr>
<td><strong>Tempo Down</strong></td>
<td>( \text{Alt} )2</td>
</tr>
<tr>
<td><strong>Reverse to Beginning</strong></td>
<td>( \text{Alt} )2</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>( \text{Alt} )5</td>
</tr>
<tr>
<td><strong>Play</strong></td>
<td>( \text{Alt} )4</td>
</tr>
<tr>
<td><strong>Conservatory</strong></td>
<td>( \text{Alt} )k</td>
</tr>
</tbody>
</table>

**Balloon Help**

- **Show/Hide Balloons**
- **Turn Balloon Help on and off**
The Studio is where you go to record and play back your own music. This feature works like a tape recorder with 7 or 8 tracks instead of 1 or 2. With it, you can record up to eight instruments, one at a time, then play them back together. You can record any song in The Miracle or record your own versions of other songs.

Note: This feature does not replace sequencing software. For serious recording, purchase a sequencer.

To go to the Studio from the Conservatory, click the room or choose Studio from the Go to menu. The tape recorder appears.

To exit this room and return to the Conservatory, choose Conservatory from the Go to menu or press $K$.

To get help, choose Show Help from the Help menu, or press $H$, or choose Show Balloons from the $?$ menu.

To record or play back a song:

1. Record your own song by choosing New Song from the File menu, or add arrangements to a song from The Miracle by choosing Open Song from the File menu. See Opening a Song.

2. Use onscreen buttons to set tempo or volume, and to select instrument tracks for recording or muting.
3. Use the Song menu to turn the metronome on or off.

4. Use onscreen buttons and/or the Transport menu to record and play back a song.

5. Use Save As... on the File menu to save your performance. See Saving a Song.

Before you start, take a minute to review the Studio's buttons and menus. See Tape Recorder Buttons and Studio Menus.

**Tape Recorder Buttons**

You can click tape recorder buttons to set the tempo, instrument tracks, muting, and volume, and to operate the tape recorder as shown below. You can also use the mouse to choose Song and Transport menu commands to do the same things. See also Studio Menus.

These tape recorder buttons correspond to the commands on the Transport menu:

- ▶▶ Click this button to stop a recording or playback session and rewind to the beginning of the song.

- ▶◁ Click this button to stop a recording or playback and rewind part of the song.

- ■ Click this button to stop the recording or playback. If a recording was in progress, the music is saved, the record track is changed, and the deck is rewound.

- ▶ Click this button to play the currently loaded song.

- ▶▶ Click this button to fast forward through a song. This may be done during playback.

- ◁ Click this button to record music and save it for later playback. All non-muted tracks play during a recording session, except the record track.

Some of these tape recorder buttons correspond to the commands on the Song menu:

- **Tempo** - At the left of the screen the tempo arrows set the speed of the song in beats per minute for recording and playback. Click ▲ or ▼ to increase or decrease the tempo. The tempo appears above the arrows.

- **Clock** - Below Tempo is a digital clock that shows the minutes and seconds you are into playing a song.
- **Instrument Tracks** - In the middle of the screen the 8 long rectangular bars are the instrument tracks. Point to a bar to choose from 127 instruments in numeric order. You can record up to eight different instruments for a song on tracks 1–8. If the song is stopped, you will hear a chord with the instrument sound you select for that track.

  *Note:* Track 8 is normally reserved for the metronome. To record on this track, be sure to turn the metronome off on the Song menu.

- **Mute** - Next to each instrument track is a large square, which is that track's mute button (turns the sound for a track off or on). Each mute button that is lit does not let you hear music on that track during recording or playback. Click mute buttons to turn muting on and off for each track.

- **Record Track** - Next to each mute button is a small square, which is that track's record button (turns the recording for a track off or on). To record music, you must select one track at a time. If you want to record more than 1 instrument, then several tracks need to be recorded, one at a time. You can only record on a track that loads an instrument patch and on the first blank track following already recorded tracks. Click record buttons to turn recording on and off for each track.

  *Caution:* Recording on a track erases any previous music, so be careful not to erase a track you want. The only way to recover an erased track is to reload the song if it was saved.

- **Volume** - At the right of the screen click and drag the scroll bar to adjust volume from 0–10. Volume 0 can be heard very softly.

**Studio Menus**

The Studio menu bar includes the menus and active commands shown below. You can open all the menus and choose commands with the mouse. For some commands, you can press the command key (⌘) and the indicated letter without pulling down the menu.

*Note:* The Song and Transport menus are alternatives to clicking some of the tape recorder buttons.
<table>
<thead>
<tr>
<th><strong>About the Miracle...</strong></th>
<th>Get information about your version of the program.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td></td>
</tr>
<tr>
<td><strong>New Song</strong></td>
<td>N</td>
</tr>
<tr>
<td><strong>Open Song</strong></td>
<td>D</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>C</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>S</td>
</tr>
<tr>
<td><strong>Save As...</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Song</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Overall Volume Up</strong></td>
<td>↑</td>
</tr>
<tr>
<td><strong>Overall Volume Down</strong></td>
<td>↓</td>
</tr>
<tr>
<td><strong>Tempo Up</strong></td>
<td>↑</td>
</tr>
<tr>
<td><strong>Tempo Down</strong></td>
<td>↓</td>
</tr>
<tr>
<td><strong>Use Metronome to Record</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Transport</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Reverse to Beginning</strong></td>
<td>2</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>3</td>
</tr>
<tr>
<td><strong>Play</strong></td>
<td>4</td>
</tr>
<tr>
<td><strong>Record</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Go to</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Conservatory</strong></td>
<td>5 E K</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Show/Hide Help</strong></td>
<td>N</td>
</tr>
<tr>
<td><strong>Balloon Help</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Show/Hide Balloons</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Opening a Song**

You can open songs shipped with the program or songs that you have recorded.

To open a song:

1. Choose **Open Song** from the **File** menu. A standard Macintosh file dialog box appears.
2. Choose a folder from the drop-down Songs field at the top of the box, then click the Open button to view the song list.

3. Select a song and click the Open button again. As soon as the song is opened, its name lights up on the tape recorder.

Saving a Song

*Important Note:* Writing over the existing song files is not recommended as The Miracle Lessons may not operate properly. When you save a recording, you should give it a different name from The Miracle song and put it in your own folder.

To save your own recording:

1. Choose Save As... from the File menu. A standard Macintosh file dialog box appears with the highlight on the song name.

2. Type the name that you want to use for the recording, then click the drop-down field at the top of the screen to select your own folder. (As needed, use the dialog box to locate the folder where you placed it on the desktop, then use the drop-down list.)

3. Click Save.

The next time you want to change the recording, select it from your own folder rather than from the original song folder.
Recording Multiple Tracks

To record multiple tracks:

1. Go to the Studio.

2. Use the Tempo buttons to adjust the beat for the song.

3. Select a track. The default is Track 1; to select another track, click its Record button.

   Example: To select Track 2, click its Record button.

Note: If you want to change the instrument for this track, point to the track bar then select an instrument from the list.

4. Click ● to begin recording your performance.

5. After the fourth metronome tick (lead beats), start and play until you are done with the track.

6. When you finish playing, take one of these options:

   • If you made mistakes, click ◀ to rewind to the beginning, discard the recording, and try again. Repeat Steps 4 and 5.

   • If you are satisfied, click ■ to stop and save the recording on that track. To record more tracks, repeat steps 3–5 until you finish recording tracks.

7. When you are done, save the recording. See Saving a Song.

Erasing a Track

If at any time you decide that you don’t like a track and want to erase it:

1. Click the instrument track that you want to erase.

2. Click ● (Record).

3. Without recording anything, click ■ (Stop).
The Miracle Piano Teaching System is the first computer program that teaches you how to read and play music on the piano. It does this by providing interesting activities and games that build your knowledge and playing skills step by step. If you’ve been through The Miracle course, you’re familiar with how this works.

But what happens inside The Miracle Piano Teaching System? This chapter describes the inner workings of the software and how The Miracle seems to “know so much” about piano playing.

The Miracle teaches piano in hundreds of small steps called Lessons, which are grouped into Chapters. One Chapter, for example, introduces rhythm. Another Chapter introduces staff notation (how music is written).

These Chapters are arranged to give you basic skills first, then to improve on these skills while introducing more advanced concepts. When you successfully complete a Lesson, you go on to the next Lesson in that Chapter. When you complete the last Lesson in a Chapter, you go on to the next Chapter.

But what happens when you don’t get through a Lesson the first time?

Human piano teachers watch you practice. If you don’t get through a Lesson properly, the teacher gives you special exercises to help you get over the problem.

The Miracle does the same thing. It “listens” to how you play, then analyzes your performance. If you had problems, it too creates a special exercise to help you overcome those problems.

The Miracle analyzes your playing both during the performance and afterward.
During your performance, The Miracle listens to make sure you are playing the right notes at the right times.

The Miracle also records your performance for later analysis. It records which keys you press, when you press them, how hard you press them, and when you release them. The Miracle calls this data the AMS, or Actual MIDI Stream.

When you finish playing, The Miracle compares your AMS with its IMS, or Ideal Music Stream. This is its recording of how the performance is supposed to sound.

When you play the piece incorrectly, it is not enough for the program to say, "Well, you played some notes wrong." The goal of an expert teaching system is to determine why you played the notes wrong, then offer corrective measures.

The Miracle classifies each of your errors as one of 200 error types. These types are sorted into 41 main categories. Some examples of the main error categories are:

- Ignoring an accidental mark
- Holding a note too long
- Playing the notes too fast
- Misunderstanding the previous accidental rule
- Ignoring a rest
- Not holding a dotted note long enough
- Striking the crack between two keys

Because different Lessons develop different skills, The Miracle pays particular attention to the error categories associated with those skills. For example, when evaluating a Lesson that focuses on rhythm, The Miracle is less picky about a few wrong notes than it is about bad rhythm.

The Miracle determines which categories are important by assigning an importance value or weight to each of the 41 error categories for that Lesson. The more important the error, the higher the number.

Each category's weight is then multiplied by the percent of mistakes made in that category. This creates a score in each of the 41 error categories.
Low scores mean you made few mistakes. If your scores are low enough, The Miracle gives you a passing grade and takes you to the next lesson. Otherwise, The Miracle identifies your most significant error (the one with the highest score), and designs an exercise to help you overcome this problem.

Each of the 41 error categories has a half-dozen or more exercises that can help you overcome a problem in that category. These exercises use The Miracle's various Activities, such as Shooting Gallery, Rhythm Practice, and so on.

When The Miracle chooses an exercise, it first eliminates any exercise for the category that is not appropriate to the Lesson. For example, if you haven't learned how to play with both hands yet, it won't ask you to play with both hands.

From the remaining exercises, The Miracle then selects the one that uses the least recent Activity. For example, if you have a pitch error, you'll get a Shooting Gallery exercise. In this way, you constantly work in a variety of Activities.

Once the exercise is selected, The Miracle creates a Chalkboard screen that tells you what your error was, and what exercise you'll do to work on it. It does this by combining two pieces of text:

• The first comes from a phrase list associated with each error category; it tells you what you did wrong.

• The second comes from a phrase list associated with the Activity; it tells you what to do to correct the problem.

The two phrases are combined using common rules of English.

Your performance in the exercise is analyzed in much the same way as your performance in the Lesson. If you receive a passing grade, The Miracle returns you to the Lesson where you had the problem. If you make many mistakes in the exercise, The Miracle creates another practice exercise.

As you work with these exercises, your skills gradually improve. Eventually, you will be able to get through the initial Lesson and move on to the next.
Getting the Most from The Miracle

With a little patience and regular practice, you'll soon be playing the piano. The Miracle helps you every step of the way, with Lessons that make learning and practicing every Chapter fun.

Completing a Chapter

At first, you'll want to do as many Chapters as you can. That's okay, but it's best to complete one Chapter's Lessons before going to the next Chapter. Try using The Miracle like this:

1. Complete a Chapter.
2. Go to the Practice Room and play all of that Chapter's pieces until you can do them well.
3. Redo the Chapter, to be sure you got it. If you practiced enough, the second time won't take long.
4. Go on to the next Chapter.

Later in the course, expect Chapters that take a week or more to complete. These Chapters are more challenging to sharpen your skills. They take time to master, so don't get discouraged. With practice, you'll get it!
Practice Makes Perfect

To get the most out of The Miracle Lessons, practice a little every day — 45-60 minutes is ideal. Even 15 minutes is better than no practice at all! You'll learn to play sooner by practicing regularly.

When you can't get through a Lesson, you may think "I'll never get this!" This happens to everybody, and just means that it's time for a rest. Play some music you already know, or stop for awhile. Remember, you will get it eventually.

The Practice Room

Use the Practice Room. There you can work on more challenging pieces, rather than just repeating Lessons. With all of The Miracle's Activities available, you can practice many ways. For example, if you're having trouble with the right hand notes in a song, select Right Hand practice and work in either the Shooting Gallery or Practice Notes. If you're having trouble coordinating both hands, select Both Hands practice and work in Practice Rhythms.

The Practice Room has many pieces that are not in the Lessons. To learn any piece using only the Practice Room:

1. Learn the left hand rhythms.
2. Learn the left hand notes.
3. Play the entire left hand part.
4. Repeat this 3-step procedure with your right hand.
5. Repeat it again with both hands.

When learning rhythms, use Practice Rhythms. If you make too many mistakes, just start again. Or, try listening to the rhythm of the piece by selecting Demo.

When learning pitches, use the Shooting Gallery at first. Take all the time you need, and try to remember the rhythms you already learned.

If you have trouble playing the entire part, go back to Practice Notes or Practice Rhythms.

Special Note to Parents

The Miracle Piano Teaching System Software works with children ages eight and up, but pre-teens may need help reading lessons, or learning to position their fingers on the keys.
This is a great way for you to get involved with your child’s piano playing. If you don’t know how to play piano, you might enjoy taking the course along with your child. You’ll both find it rewarding to learn a creative skill together.

Children make the best progress when practicing is fun. To convince your child that practice is fun, show an interest in his or her progress during and after practice. Your excitement about the child’s progress can really inspire him or her to continue. This is especially fun for everyone in activities where The Miracle accompanies your child’s performance.

**Special Note to Teachers**

The **Miracle** can enhance your teaching with practice exercises that are possible only on a computer:

- **Pointers** - Give visual *what to play* cues that builds music reading confidence.
- **Pitch Practice Activities** - Advance pointers to new notes only when you play the correct pitch.
- **Properly Adjusted Metronome** - Continuously reinforces good rhythm.
- **Rhythm Practice Activities** - These play the proper pitches no matter what key you press. This lets the student actively participate in partially demonstrating the piece.
- **Shooting Gallery** - Makes practicing fun while developing note reading and rhythm skills.
- **Special Exercises** - Help students overcome specific problems. These are given as needed, when The Miracle detects error trends in a practice session.
- **Different Display Formats** - Provide variety and help students focus on specific aspects of a piece.
- **Practice is constantly varied and fun** - Students tend to practice more — and regularly!

As the teacher, these tools can effectively speed your students’ progress. This gives you time to focus on:

- Maintaining good hand position.
- Phrasing and tapering of phrases.
- Rubato or subtleties in the tempo.
NOTE TO EXPERIENCED PLAYERS

Experienced piano players often find The Miracle course a wonderful way to refresh their memories and improve their playing skills. Also, since The Miracle is designed to teach music to beginners, experienced players can zip through the initial Lessons. Complete the first two Chapters, to see how the system works. Then skip ahead as far as you want.

The interactive nature of The Miracle lets it teach piano using unique, new techniques that only a computer can provide. You'll find learning with it quite different from a course presented by traditional instructors, although all of the standard elements are there. These elements are sometimes presented in a different order than they are in standard courses. As a result, you might find an occasional Lesson that covers things you already know.
In the Pidgin trading language of New Guinea, the piano is called "a box of music with teeth like a crocodile, suppose you fight it hard, it cries out." Amazingly, this accurately describes the piano's earliest ancestor.

**Pipe Organ**

The piano's earliest ancestor is the organ, which was invented in the 3rd century B.C. by the Greek engineer Ktesibios. His Hydraulos was the first keyboard instrument. The wooden "keys" looked like tongues and worked like hydraulic pumps. Key presses used water pressure to force air through pipes, which made sounds. This was not easy. Hydraulos players had to pound keys with their fists to fight the water pressure!

Pipe organs with easier actions appeared around the 6th century, and quickly became the favorite instrument of the Church. They are still popular there today.

**Clavichords**

The clavichord was the first keyboard instrument that used strings instead of pipes. Invented during the Middle Ages, the clavichord became popular in the 1400s. Key presses moved flattened brass pins against brass strings that vibrated when struck. The pressure on the keys controlled the volume; however, at its loudest, the clavichord was as quiet as a mouse.

This made the clavichord ideal for home practice and the instrument of choice in nunneries. Nuns loved it, because they could play without disturbing those around them.
**Harpichords**

An Italian, Giovanni Spinnetti, was less impressed. He wanted a more powerful instrument that made louder sounds. To increase the volume, Spinnetti made the soundboard and strings longer. On his harpsichord, key presses firmly plucked strings with quills. This made the loud sound that Spinnetti wanted, but there was no way to quiet it down!

**Orchestras**

During the 16th century, orchestras appeared with harpsichords as standard instruments. Performances by early orchestras were either private affairs for royalty, or associated with a new musical form called opera.

Although keyboard music became popular, few people owned keyboards. Because harpsichords and clavichords were complicated, hand-made instruments, they were quite expensive. Royalty and wealthy people displayed them proudly, but they were rarely seen elsewhere. Music was an art for the rich.

**Public Performances**

Public performances by individual musicians were unheard of until 1672. That year an English violinist, John Bannister, realized there was money to be made from them. At 4 o'clock every afternoon, Bannister charged “a shilling a head” for anyone who wanted to come to his house and listen to musicians.

Keyboardists introduced themselves to the public in 1678 when another Englishman, Thomas Britton, rose to fame holding concerts in the loft above his coal store. Handel (best known today for his Messiah) was one of many who performed on the harpsichord in Britton's well-heated loft. Here is an early ad for these performances:

“ANYBODY THAT IS WILLING TO TAKE A HEARTY SWEAT MAY HAVE THE PLEASURE OF HEARING MANY NOTABLE PERFORMERS IN THE CHEERING SCIENCE OF MUSICK.”

By the early 1700s, public performances were common, and the harpsichord's volume made it the logical keyboard instrument to play. This frustrated many composers, who wanted subtle volume variations to express their music. In fact, Johann Sebastian Bach publicly called the harpsichord a "soulless instrument."

What the world needed was an instrument that combined the harpsichord's volume with the clavichord's expressiveness.
The Piano is Born in Italy

In 1709, the piano was born. The inventor, Italian harpsichord designer Bartolommeo Cristofori, called it the Gravicembalo Col Piano E Forte (Harpsichord with Loud and Soft).

The Pianoforte, as it was known, used hammers and dampers to control the strings. A key press threw a small wooden hammer up against a string, making it vibrate. A hard key strike struck the hammer hard, making a loud note. A soft key strike struck the hammer softly, making a quieter sound. When the key was released, a damper fell on the string, silencing it. This is essentially how pianos work today.

Cristofori was excited about his invention. Unfortunately, no one else seemed to be. Despite the piano's advantages, the harpsichord continued to dominate the musical world.

German Piano Manufacturing

A German organ maker, however, was excited by Cristofori's hammer action design. In 1725, Gottfried Silbermann began copying Cristofori's piano and promoting it throughout Germany. But he too fought an uphill battle to get it recognition.

In 1736, Silbermann tried to promote the design by introducing his piano to one of the harpsichord's harshest critics, the great Johann Sebastian Bach. Silbermann had high expectations as Bach played the instrument and considered it.

The famous composer agreed that the piano had a pleasant tone, but declared that the treble was too weak and the action too stiff. This infuriated Silbermann, who refused to speak to Bach for many years.

Eventually, Silbermann improved the features of the piano that Bach criticized. By 1747, 11 years after his introduction to it, Bach said the piano was "coming along."
**First Public Concert**

The first public concert featuring a piano was held in 1767, 58 years after the instrument’s invention. An ad promoted the concert as a benefit by a “Miss Brickler,” who sang while accompanied “on a new instrument called a Piano Forte.”

Although the piano was well received at the Brickler concert, it was a performance in the following year by Johann Christian Bach (the youngest son of Johann Sebastian Bach) that finally brought the instrument public acceptance. Suddenly, pianos of numerous designs appeared all over Europe and the New World. Future American President, Thomas Jefferson, an extraordinary violinist and passionate music lover, bought a piano in 1771.

**More Piano Manufacturing**

At this time, the largest manufacturers of pianos were the French, led by Sebastien Erard, and the English, led by John Broadwood. French pianos were known for their crisp, delicate touch, while the English pianos were known for their fullness of sound. The virtues of each were a topic of many arguments among composers in the late 1700s.

The first American piano factory opened in Philadelphia in 1774, manufacturing instruments in the English design.

**Mozart**

Around that same time, the fame of an amazing keyboard performer was spreading across Europe. Wolfgang Amadeus Mozart was a child prodigy of exceptional talent. When the child began composing music at age four, his father realized there was money to be made. By age six, Wolfgang was paraded past the royalty of Europe, stunning them with his performances.

At age 14, Mozart was so skilled that at a single exhibition, he was challenged to play the following:

“a Symphony of his own composition; a harpsichord concerto which will be handed to him, and which he will immediately play prima vista (on first look); a Sonata handed to him in like manner, which he will provide with variations, and afterwards, repeat in another key; an Aria, the words for which will be handed to him, and which he will immediately set to music and sing himself, accompanying himself on the harpsichord; a Sonata for harpsichord on a subject given to him by the leader of the violins; a strict Fugue on a theme to be selected, which he will improvise on the harpsichord; a Trio, in which he will execute a violin part all’
improviso (improvised); and finally, the latest Symphony composed by himself."

Mozart met the challenge and the concert was a success.

Mozart was another composer who disliked the limits of the harpsichord. Unlike Bach, he embraced the piano, making it a serious professional instrument.

With the piano's endorsement by Mozart and his contemporaries, piano teachers soon found themselves in demand. By 1779 in Vienna, over 300 piano teachers were making a comfortable living.

BEETHOVEN

In 1787, a 31-year-old Mozart heard a performance by a young prodigy, the somber but brilliant Ludwig van Beethoven.

Mozart was never easily impressed. He correctly believed that few, if any, composers were even close to being his equal. Of the 17-year-old Beethoven, however, he claimed "This young man will leave his mark on the world."

Not everyone agreed with Mozart. Seven years later, when Beethoven studied counterpoint with Johann Georg Albrechtsberger, the famous Viennese instructor insisted that Beethoven "has learned nothing, and will never do anything properly."

Albrechtsberger was frustrated because Beethoven's active imagination distracted him from the dry, traditional course of study. This imagination, however, was Beethoven's strength, and it made him one of the greatest composers in the world. To him, music was just a puzzle to be solved. His imaginative solutions yielded works of great power and expression, often built from seemingly dull themes. In fact, Beethoven's performances were so powerful that he hired musicians to run around the piano and remove the strings and hammers that he broke.
**Piano Frames**

Then again, Beethoven's performances had to be powerful. Concert halls were getting bigger and outgrowing the carrying power of 18th century pianos. Although manufacturers knew that thicker strings would increase the piano's volume, the 16-ton tension required to tune such strings would snap a wooden piano frame like a twig.

A Bostonian, Alpheus Babcock, solved the problem in 1830 by making a cast iron piano frame. Within a few decades, his design revolutionized the industry. A variation of Babcock's cast iron design is still standard in today's pianos, in which the thicker strings require tensions of over 30 tons!

**Russian School**

Babcock's design helped the rise of pianists such as Anton Rubinstein, a Russian known for thunderous performances. In Europe, most critics wondered at all the fuss, since Rubinstein often played sloppily, botching notes during his energetic recitals. Audiences, however, loved the energy of Rubinstein's performances, and left his concerts feeling well entertained. Today Rubinstein is remembered as the founder of the Russian School of piano playing, which emphasizes fiery performances and virtuosity.

**Liszt**

Another exciting performer was Franz Liszt, whose handsome features, unrivaled skill, and dramatic playing style got the same response from the women of his day that the Beatles got from their fans in the 1960s. Women charged the stage, throwing jewels and shrieking in ecstasy. A fight always broke out over the green gloves that Liszt left on stage after the performance. One woman supposedly fished through trash for a cigar stub that Liszt smoked, then carried it in her bosom until she died.
CHOPIN

Although Liszt was the most popular pianist in Europe, another composer, Frederic Chopin, had a greater impact.

Chopin was a small, foppish man to whom social circles and proper fashion meant everything. Although lacking Liszt’s personal magnetism, he amazed audiences by playing with a grace and agility that seemed impossible to achieve with his tiny, delicate hands. Today, Chopin is remembered as the pioneer of a style of music, called Romanticism. This form, which is still popular today, concentrated on the emotional aspect of music instead of the technical, and often abandoned the rigid forms imposed by the earlier composers.

THE STEINWAY PIANO

As music changed, so did the piano. In 1836, German cabinet maker Heinrich Steinweg of Steinway & Sons built a piano in his kitchen, which combined Babcock’s cast iron frame with the recent English notion of pedals and the hammer action improvements made by the French. It was the first modern piano, and the beginning of the most prestigious piano manufacturer, Steinway & Sons.

In 1853, Steinweg moved his business and family to New York, where it remains today. By this time, piano playing had spread like wildfire, and the instruments were everywhere. They were even common in the rugged American west, where piano players appeared in dance halls, bar rooms, and bordellos.

AMERICAN PIANO

By 1870, there were over 7,000 piano manufacturers in the USA alone, with manufacturing production increasing almost twice as fast as the population. Over the next 20 years, one out of every six Americans was involved in the piano industry.

During this time, manufacturers began experimenting with stranger and stranger variations on their designs. Inventors did anything to appeal to the public’s piano obsession. Some of these pianos were round. Others were square or wing shaped. Still others stood upright. Some had keyboards on each side so that several pianists could play at once. The Janko piano keyboard looked like a typewriter. And Emil J. Cost made the smallest working piano in the world, measuring 1/2” x 3 3/8” x 6 1/2” — about the size of a short paperback book!
Player Piano

The most unique of these inventive pianos required no pianist. The player piano could duplicate a performance by rolling a hole-punched sheet of cardboard past a line of air jets. Each hole was one note of the performance. As a hole passed a jet, air shooting through it fired the appropriate hammer at the piano’s strings.

These player pianos accurately recorded many aspects of a performance, including dynamics and pedal activity. As a result, surviving player piano rolls provide us with accurate recordings of performances that were played long before the advent of modern recording equipment.

Ragtime

A wide variety of music was available for player pianos, but the most popular of the day was a new style of playing called Ragtime, which stood for ragged time. Ragtime tunes, called Piano Rag, were highly syncopated pieces that favored fast tempos and a more staccato flow.

As a result of Ragtime, the piano’s popularity increased more than ever. By the turn of the century, almost 365,000 pianos a year rolled out of factories. The stranger designs mostly disappeared, leaving pianos primarily in the form of either wing-shaped Grands or Uprights. The Grand piano produced louder and superior sounds, so was used for concert performances. The Upright’s smaller footprint, however, made it the piano of choice for the home.

Jazz

The Upright was also the favorite of artists in another new style of music, Jazz. This uniquely American form had its roots in both Blues and Ragtime. Unlike these single instrument styles, however, Jazz was played by small bands, usually with a piano, a cornet, a trombone, and a bass.

The thing that made early Jazz most unique, however, was that it was rarely written down. Few Jazz musicians could read music. Instead, these musicians depended on their skill, intuition, and experience. The Jazz age heralded a return to the art of improvisation which, though applauded in Mozart’s day, was frowned upon by the classical performers of the late 19th century, and is still uncommon in classical performances today.
Electric Piano

The early 1950s saw the most unique addition to the piano since the cast iron frame — electricity. This addition was first made by the Wurlitzer Company. With it, the era of portable pianos had arrived.

In an electric piano, the hammers strike metal reeds or rods whose vibrations create electrical signals. These signals are then sent to an amplifier and a speaker which reproduces them as sound. The sound, however, is somewhat different from that of a traditional piano. As a result, the electric piano found a home in new, rather than classical forms of music.

Moog Synthesizer

While the electric piano was sparking interest, German inventors and composers were learning to produce sounds by entirely electronic means. They used a device called an oscillator, which, when coupled with a keyboard by Robert Moog in 1965, formed the first synthesizer.

Using this Moog synthesizer, composer Walter Carlos created the 1969 album Switched on Bach. Bach's music lent itself magnificently to the unusual sounds of this new keyboard instrument. The result legitimized the synthesizer while introducing the works of the baroque period's greatest composer to a new generation.

Sound Sampling

Synthesizers have made enormous advances since the early Moogs. Although today's synthesizer can still make unique electronic sounds, it can also accurately reproduce the sound of many traditional instruments. This is done by a process called sampling. The process starts by making a digital recording of notes played by a real instrument. Using computer technology, the sound is converted into a series of numbers, which are later converted back to sound. Compact Discs also work by the same process.

In synthesizers, these numbers are stored in a computer chip rather than on a disc. When the keyboardist plays a note, the synthesizer converts the numbers for that note back into sound. The result is the exact sound of the instrument that was originally recorded. By the early 1980s, computer technology was also being used to attach sequencers to electronic keyboards. Performances were digitally recorded, edited or overlayed with additional musical sequences, then played back through the synthesizer. Unfortunately, each manufacturer's sequencer only worked with its own synthesizer.
MIDI

In 1982, representatives of the top synthesizer manufacturers met to discuss this compatibility problem. The result was MIDI (Musical Instrument Digital Interface), which became the standard format for sending data between instruments and sequencers (or other instruments). MIDI is so versatile that it is also used to control stage lighting, special effects, and video equipment. All manufacturers, including The Miracle's, support the MIDI standard today.

The combination of sampling and MIDI changed the way many composers work. Making a recording no longer requires dozens of musicians, a studio, and a room full of recording equipment. A single composer with a sequencer and a keyboard can create the sound of everything from a rock band to a symphony orchestra. To do this, the composer uses the synthesizer to create one instrument sound at a time, then sequences all sounds together. In fact, most of today's movie soundtracks are created in exactly this manner.

MIDI keyboards are also a boon to Rock musicians. A keyboardist can replace an entire wind, brass, or string section, providing an instrumentation range once impossible to create in live Rock performances. In addition, some bands use sequencers to help them perform songs that normally require many more musicians.

The Miracle

In The Miracle Piano Teaching System Software, you'll use a synthesizer to learn an instrument with a rich 300-year tradition ... the piano.
Congratulations! You’ve finished The Miracle Piano Teaching System Software and mastered the basics of an exciting skill. You have every reason to be proud!

You now know how to:

• Recognize commonly found symbols in piano sheet music.

• Read and play notes, rhythms, and fingerings for a piece.

• Separate pieces into smaller sections and parts, such as pitch and rhythm.

• Coordinate changing keyboard positions and chords.

• Blend notes using the pedal.

Now, continue your training by learning pieces on your own. Select pieces that interest you and try to practice daily. Your skills in both playing and sight reading will continue to improve.

Practice the way you did with The Miracle for 45 minutes to an hour each day. Don't forget that playing for even a few minutes is better than not playing at all.
SELECTING NEW PIECES

Visit your local music store, browse through the sheet music section, and choose some music that you like. Here are some guidelines.

Consider trying some of the following:

General

• Scott Joplin piano rags
• Spiritual and Gospel arrangements

Contemporary

• Folk music collections
• Movie soundtracks
• Popular songs
• Rock collections, such as The Beatles, Elton John, and Billy Joel
• Beginning Jazz collections

Classical

• Bach’s 2-Part Inventions
• Barrokh’s Mikrokosmos
• Schumann’s Kinderszenen
• Sonatas and sonatinas by Clementi, Kuhlau, Haydn, and Mozart
• Easy pieces by Grieg

GETTING FURTHER INSTRUCTION

In addition to practice, you can further your studies by taking piano and/or music theory lessons through group classes or private instruction.

Group Piano Lessons

Group lessons are an excellent way to continue from The Miracle course. Try your local Parks & Recreation departments, community programs, adult education programs, and community, state, and private colleges.

Private Piano Lessons

There is no substitute for a good piano teacher to improve your playing technique, phrasing, dynamics, touch, musical style, and interpretation. With a good teacher, you’ll learn different styles and more difficult pieces. Many piano teachers include theory lessons in their training programs. Playing in public is fun and exciting, and with a good piano teacher you’ll get a chance to do recitals, competitions, and other performances.
To find a good teacher, contact the music department in a nearby college and ask for a list of qualified music teachers in your area.

Theory Classes

Music theory teaches you the underlying concepts behind music and how it is put together. Among other things, you’ll learn about the formation of chords and chord progressions.

Rock and Jazz musicians need music theory because they must improvise as they play. Classical pianists use it to recognize patterns in complex pieces. If you want to compose music, theory is invaluable.

Theory classes are also offered through community programs, adult education programs, and community, state, and private colleges. Prices vary.

If You're Interested in Playing Jazz

A private instructor is your best bet for learning Jazz and improvisation. Again, your local college is a good source on where to find a qualified instructor. If you want to learn Jazz, music theory is invaluable.

If You're Interested in Playing Rock

Keyboardists are in demand by Rock bands. If you're interested in Rock, learn about improvisation, Blues, and Jazz. Make up stuff you like and play it. Listen to other Rock keyboardists to get ideas and discover different styles of playing. Copy styles you like while you develop your own.

Playing With Friends

Playing music with your friends is a fabulous, fun way to learn any style of music you choose. There is a wide range of classical material for piano and one or two other instruments, and a rich repertoire for Jazz and Rock bands.

Playing in a group increases your confidence, improves your sight reading, develops your rhythm skills, and introduces you to new challenges and material. Most importantly, you'll get excited about practicing with your friends.
LISTENING TO MUSIC

If you want to be a musician, the best thing to do is listen to a lot of music. Choose music that you like, for piano or for groups and orchestras.

Here are some music artists you may want to consider:

Rock
The Doors
Joe Jackson
Billy Joel
Elton John
Jerry Lee Lewis
Talking Heads
Tori Amos

Jazz
Bill Evans
Oscar Peterson
Art Tatum
Teddy Wilson
Keith Jarrett
Herbie Hancock

Classical
Bach  Mozart
Beethoven  Prokofiev
Brahms  Rachmaninoff
Chopin  Ravel
Debussy  Scarlatti
Gershwin  Schumann
Liszt  Tchaikovsky

Friends and record store employees can also offer suggestions.
GLOSSARY

Accidental
A note that appears in staff notation preceded by a sharp, flat, or natural symbol.

Bar
See Measure.

Bar Line
The vertical line that separates measures in staff notation.

Baroque
A period of musical history which lasted from about 1600 through 1750. Notable composers of this period include Bach, Couperin, Handel, Pachelbel, and Scarlatti.

Bass Clef
The symbol at the left edge of a staff that identifies it as a bass staff. Sometimes called an F-clef, because it indicates that the note on the second line of the staff is an F.

Bass Line
The notes played on the bass staff (in piano, these are usually, but not always, played with the left hand).

Bass Staff
A staff that begins with a bass clef, whose note pitches are normally associated with the male voice and low-pitched instruments. On the piano, it is associated with the left half of the keyboard.

Beam
A thick line that connects the stems of two or more consecutive notes with durations lasting an eighth note or shorter. It is used to simplify notation and improve readability of rhythm information.

Beat
A short interval of time, used to keep rhythm. Each measure of a piece is made up of a fixed number of these beats. When using a metronome, one click is usually associated with one beat.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Broken Octaves</td>
<td>A musical pattern in which notes alternate back and forth between octaves. This pattern is normally found in the bass line.</td>
</tr>
<tr>
<td>Cembalo</td>
<td>Harpsichord.</td>
</tr>
<tr>
<td>Channel</td>
<td>An electronic band or frequency. MIDI has 16 channels. You can send a different voice (patch) to each channel.</td>
</tr>
<tr>
<td>Channel Map</td>
<td>List of channel patch assignments for the current musical output device.</td>
</tr>
<tr>
<td>Chord</td>
<td>Two or more keys pressed at the same time. 2-note chords are sometimes called Double Notes. Chords are written as several note heads attached to one stem.</td>
</tr>
<tr>
<td>Clef</td>
<td>A symbol that appears at the left of each staff to indicate what notes the lines and spaces of the staff represent. Two types are used in piano notation: treble clef and bass clef.</td>
</tr>
<tr>
<td>Coda</td>
<td>The finale of either a piece or major section of a piece. In order to create an impression of finality, codas generally use a pattern of notes or rhythms different from the rest of the piece.</td>
</tr>
<tr>
<td>Common Time</td>
<td>A time signature of 4 beats per measure, where each beat is the duration of a quarter note. Also called 4/4 time.</td>
</tr>
<tr>
<td>Compound Time</td>
<td>Time signatures in which the number of beats per Signature measure can be evenly divided by 3.</td>
</tr>
<tr>
<td>Contrapuntal</td>
<td>In counterpoint. Playing 2 or more entirely independent parts (melody line, bass line, etc,) at the same time.</td>
</tr>
<tr>
<td>Contrary Motion</td>
<td>A musical pattern in which notes of rising pitches appear on one staff while notes of lowering pitches appear on the other staff.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Crossing</td>
<td>A fingering technique that involves moving the thumb to a key that rests under the fingers or moving the fingers over the thumb that is holding a note down. It is one way to change keyboard positions.</td>
</tr>
<tr>
<td>Damper</td>
<td>A felt-covered device that silences the vibration of a piano string when the corresponding key on the keyboard is released.</td>
</tr>
<tr>
<td>Damper Pedal</td>
<td>The right pedal on the piano. This pedal lifts all of the dampers, allowing the strings to vibrate freely, even after their corresponding keys are released. It is also called the loud pedal.</td>
</tr>
<tr>
<td>Dotted Note</td>
<td>A note that is played for one-and-a-half times its normal duration.</td>
</tr>
<tr>
<td>Double-Note</td>
<td>A 2-note chord.</td>
</tr>
<tr>
<td>Duration</td>
<td>The amount of time a note is played, in relation to the other notes.</td>
</tr>
<tr>
<td>Eighth Note</td>
<td>A note whose duration is one-eighth that of a whole note. It appears in staff notation as a solid circle attached to a stem with a flag.</td>
</tr>
<tr>
<td>Eighth Note Rest</td>
<td>A rest whose duration equals an eighth note. Also called an Eighth Rest.</td>
</tr>
<tr>
<td>Finger Independence</td>
<td>The ability to move each finger independently of the others.</td>
</tr>
<tr>
<td>Finger Number</td>
<td>The numbers that appear above or below the notes in staff notation to indicate which fingers to use.</td>
</tr>
<tr>
<td>Fingering</td>
<td>The coordination of hand positions to play the notes of a piece smoothly.</td>
</tr>
<tr>
<td>Flat</td>
<td>The sign for a note one half-step lower than the indicated note.</td>
</tr>
<tr>
<td>Forte</td>
<td>A musical term meaning loud.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fortepiano</td>
<td>The early name given to the piano (literally, loud-soft).</td>
</tr>
<tr>
<td>Grand Piano</td>
<td>A type of piano in which the strings lie horizontally. It has a graceful curve on one side.</td>
</tr>
<tr>
<td>Half Note</td>
<td>A note that is played for half of the duration of a whole note. In staff notation, it looks like hollowed-out circle with a stem.</td>
</tr>
<tr>
<td>Half Note Rest</td>
<td>A rest that lasts for the same duration as a half note. It is also called a Half Rest.</td>
</tr>
<tr>
<td>Half Step</td>
<td>The distance between two adjacent keys on the keyboard, counting both white and black keys.</td>
</tr>
<tr>
<td>Hand Position</td>
<td>The proper way to hold the fingers while playing.</td>
</tr>
<tr>
<td>Imitative Piece</td>
<td>A type of music in which one musician (or hand) plays a sequence of notes with a particular rhythmic pattern, then the other musician (or hand) plays a sequence of equal length, using the same rhythmic pattern. In many cases, the sequences have identical melodies.</td>
</tr>
<tr>
<td>Improvisation</td>
<td>The art of creating music without following a specific written or practiced routine.</td>
</tr>
<tr>
<td>Interval</td>
<td>The distance between two keys on the keyboard.</td>
</tr>
<tr>
<td>Jazz</td>
<td>A form of music that developed in the United States in the early 1900s from elements of Blues and Ragtime. Its style is often characterized by long improvisational solos and extensive use of syncopation.</td>
</tr>
<tr>
<td>Key Signature</td>
<td>An indicator at the beginning of a staff that identifies which lines and spaces of the staff should be played sharp or flat.</td>
</tr>
<tr>
<td>Keyboard Position</td>
<td>The placement of the hand on certain notes of the keyboard. It is often necessary to move the hand to different keyboard positions during play.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lead Beats</td>
<td>One measure's worth of beats, counted off before a piece starts for the purpose of setting tempo.</td>
</tr>
<tr>
<td>Ledger Lines</td>
<td>Short horizontal lines above or below the staff, attached to the stem of a note. Used to indicate the pitch of notes that fall outside the range of the staff.</td>
</tr>
<tr>
<td>Legato</td>
<td>A technique of playing in which notes appear to flow together smoothly.</td>
</tr>
<tr>
<td>Length</td>
<td>The duration of a note.</td>
</tr>
<tr>
<td>Local Off</td>
<td>You don't hear the actual sounds of keys on the keyboard when struck. Some examples of Local Off are the rhythm exercises in <em>The Miracle</em>.</td>
</tr>
<tr>
<td>Local On</td>
<td>You hear the sounds of keys on the keyboard when struck.</td>
</tr>
<tr>
<td>Loud Pedal</td>
<td><em>See Damper Pedal.</em></td>
</tr>
<tr>
<td>Measure</td>
<td>A group of notes, framed on the staff between vertical bars called bar lines. Each measure in a piece has the same number of beats. Normally, the first beat in a measure is stressed. Also called a <em>Bar</em>.</td>
</tr>
<tr>
<td>Melody</td>
<td>The tune or theme of a piece. In piano scores, it usually appears on the treble staff.</td>
</tr>
<tr>
<td>Metronome</td>
<td>A device which makes evenly spaced tick sounds to help musicians maintain tempo.</td>
</tr>
<tr>
<td>Middle C</td>
<td>The musical note C that is closest to the center of the keyboard.</td>
</tr>
<tr>
<td>MIDI</td>
<td>Acronym for Musical Instrument Digital Interface, which is the system that makes electronic keyboards compatible with <em>The Miracle</em> software.</td>
</tr>
<tr>
<td>MIDI IN</td>
<td>A MIDI input port that receives information from <em>The Miracle</em> software on your Macintosh.</td>
</tr>
</tbody>
</table>
MIDI OUT  A MIDI output port that sends information to The Miracle software on your Macintosh.

Multi-Timbre  More than one instrument voice sounding at the same time.

Natural  The sign for a note that is neither sharp nor flat.

Octave  The closest distance between two notes with the same letter name. Including both white and black keys, this is a range of 12 notes.

Oscillator  An electronic wave form generator used in synthesizers to create sounds.

Ostinato Rhythm  A rhythmic pattern that repeats continuously.

Parallel Motion  A musical pattern in which notes on both staves rise and fall in pitch at the same time.

Patch  The number assigned to a musical voice or timbre in The Miracle software.

Patch Mapping  List of all patches for the current musical output device.

Piano  A musical term meaning soft. Also, short for pianoforte.

Pianoforte  A keyboard instrument that uses a system of hammers and dampers to control the vibration of strings.

Player Piano  A type of piano invented in the late 19th century that required no performer.

Playing by Interval  A technique for reading music in which distances between notes on the staff are associated with distances between keys on the keyboard.

Previous Accidental Rule  A special case to the normal rules of staff notation. When an accidental appears in a measure, the accidental remains in effect for future occurrences of notes on that line or space for the rest of the measure. See Accidental.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quarter Note</td>
<td>A note that is played for one quarter the duration of a whole note. In staff notation it appears as a solid black circle with a stem.</td>
</tr>
<tr>
<td>Quarter Rest</td>
<td>A rest that lasts for the same duration as a quarter note.</td>
</tr>
<tr>
<td>Ragtime</td>
<td>A style of piano music that first appeared in the late 1800s. Pieces are highly syncopated, favor fast tempos and a more staccato flow.</td>
</tr>
<tr>
<td>Rest</td>
<td>A moment of silence in music of specific duration.</td>
</tr>
<tr>
<td>Rhythm</td>
<td>The proportions between notes of different durations.</td>
</tr>
<tr>
<td>Romanticism</td>
<td>School of composing and playing with emphasis on subjective interpretation, emotional qualities, and freedom of form.</td>
</tr>
<tr>
<td>Russian School</td>
<td>A style of piano begun by Russian composer Anton Rubinstein that emphasizes fiery performances and virtuosity.</td>
</tr>
<tr>
<td>Sequence</td>
<td>A pattern of notes and rhythm that repeats three or more times with each repetition beginning higher or lower than the previous one.</td>
</tr>
<tr>
<td>Sharp</td>
<td>The sign for a note one-half step higher than the indicated note.</td>
</tr>
<tr>
<td>Sight Reading</td>
<td>Playing a new piece without first studying or practicing it.</td>
</tr>
<tr>
<td>Sixteenth Note</td>
<td>A note played for 1/16th the duration of a whole note. In staff notation it appears as a solid black circle with a stem possessing two flags.</td>
</tr>
<tr>
<td>Sixteenth Note Rest</td>
<td>A rest that has the same duration as a sixteenth note. Also called a <em>Sixteenth Rest</em>.</td>
</tr>
<tr>
<td>Soft Pedal</td>
<td>The left pedal on the piano. When pressed, the piano produces a more muffled sound.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sostenuto</td>
<td>See Sustaining Pedal.</td>
</tr>
<tr>
<td>Soundboard</td>
<td>The wooden surface over which the strings of a piano are stretched. The sound of the vibrating strings resonate off the soundboard.</td>
</tr>
<tr>
<td>Staccato</td>
<td>A style of playing in which notes are crisp and separated by silences of varying lengths.</td>
</tr>
<tr>
<td>Staff</td>
<td>A set of 5, evenly-spaced horizontal lines. Each line represents a different note. Each space between the lines also represents a note. The space above and below the staff can also represent notes; see Ledger Lines.</td>
</tr>
<tr>
<td>Staff Notation</td>
<td>The written form of music.</td>
</tr>
<tr>
<td>Stretches</td>
<td>Fingerings that require skipping notes with adjacent fingers.</td>
</tr>
<tr>
<td>Sustaining Pedal</td>
<td>The middle pedal on a piano. This pedal sustains the sound of a note being played (and only that note) beyond the time when the finger is lifted from the key.</td>
</tr>
<tr>
<td>Syncopation</td>
<td>A style of rhythm in which accented notes appear between beats, rather than on them.</td>
</tr>
<tr>
<td>Synthesizer</td>
<td>A musical instrument, usually having a keyboard, that can electronically create a wide variety of sounds.</td>
</tr>
<tr>
<td>Tapping</td>
<td>A method of learning rhythm in which the pianist plays a single note on the keyboard in time with the rhythm of a piece of music.</td>
</tr>
<tr>
<td>Tempo</td>
<td>The overall speed at which a piece is played.</td>
</tr>
<tr>
<td>Theme</td>
<td>The main melody of a piece, for which the piece is known and recognized.</td>
</tr>
<tr>
<td>Third</td>
<td>An interval of two notes separated by one note. It is written on two consecutive lines or two consecutive spaces.</td>
</tr>
</tbody>
</table>
A curved line that connects two or more notes of equal pitch. Such notes are played as a single note, lasting for the duration of all the tied notes combined.

The numbers that appear at the left of the first measure of a piece, indicating the number of beats per measure (upper number) and the note duration to which a beat is equal (lower number).

The symbol at the left edge of a staff that identifies it as a treble staff. Sometimes called a G-clef, because it indicates that the note on the second line of the staff is a G.

A staff that begins with a treble clef, whose note pitches are normally associated with the female voice and high-pitched instruments. On the piano, it is associated with the right half of the keyboard.

Three notes played in the same time it would normally take to play two. They appear in notation as a set of beamed notes with a small 3 above the beam.

A term meaning Soft Pedal.

A type of piano whose strings are mounted vertically, thus requiring less floor space than a grand piano.

A modified repetition of a basic theme.

A note whose duration is 4 times that of a quarter note. In staff notation, they appear as a hollow circle with no stem.

A rest that has the same duration as a whole note. Also called a Whole Rest.
Macintosh Conventions

The Miracle Piano Teaching System uses these standard Macintosh principles:

- A standard Macintosh menu bar appears on top of the screen. When you open a pull-down menu, active commands are boldface (lit), inactive commands are dimmed, and any keyboard shortcuts are shown. You can click an active command or press its shortcut keys, such as Q to Quit. As you use the program, notice that menus appear and disappear on the menu, depending on the activity that you are doing.
  *Note:* The Edit menu is only active when you are adding or editing a student.

- The mouse operates all program features and some keyboard features.

- Balloon help is available. You can show or hide balloons.

Mouse and Keyboard

With any feature of The Miracle, you can use standard mouse actions, including:

- **Click** - Point and press the mouse button. You click to go to rooms from the Conservatory; to choose command buttons in Lessons and rooms; to open menus and choose commands from the Macintosh menu bar at the top of the screen; and to select from lists, fields, and check boxes, or choose commands in dialog boxes.

- **Double-click** - Point and click the mouse button twice rapidly. For example, you can double-click songs in dialog boxes to open them for practice.
• **Click and drag** - Point, hold down the mouse button, and drag the mouse. You click and drag to “thumb” on the horizontal or vertical scroll bars to reposition lists, such as songs, or settings, such as volume.

For some but not all features of **The Miracle**, you can use a keyboard alternative to the mouse, including:

• **Typing** - When you add a new student, you type that person’s name.

• **Scrolling** - Press cursor keys to move up and down selection lists as alternatives to clicking scroll bar arrows or clicking and dragging the scroll bar thumb.

• **Okaying** - Press Return to confirm a choice. This is an alternative to double-clicking and to clicking the OK button.

• **Canceling** - Press Esc to cancel a choice (an alternative to clicking the Cancel button.)

• **Command Keys** - Press `⌘` and the letter or number shown next to certain menu commands to choose those commands without a mouse. For details see *Quick Reference*. 

# Quick Reference

This chart compares common uses for the mouse and the Macintosh keyboard.

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Mouse Action</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start up the Macintosh</td>
<td>Double-click desktop icon</td>
<td></td>
</tr>
<tr>
<td>Pull down a menu</td>
<td>Click and drag</td>
<td></td>
</tr>
<tr>
<td>Go to next Clockboard</td>
<td>Click the icon button</td>
<td></td>
</tr>
<tr>
<td>Select a dialog box field</td>
<td>Click</td>
<td></td>
</tr>
<tr>
<td>Move up/down a line in text</td>
<td>Click</td>
<td></td>
</tr>
<tr>
<td>Move up/down 1 page in text</td>
<td>Click scroll bar arrows</td>
<td>PAGE UP/PAGE DOWN</td>
</tr>
<tr>
<td>Move to top/bottom of list</td>
<td>Click and drag scroll bar</td>
<td></td>
</tr>
<tr>
<td>Open a selection</td>
<td>Click</td>
<td></td>
</tr>
<tr>
<td>Close a selection</td>
<td>Click Show/Close or Help menu</td>
<td>ESC</td>
</tr>
<tr>
<td>Go to current help</td>
<td>Choose Hide/Show or Help menu</td>
<td>ESC</td>
</tr>
<tr>
<td>Exit online help</td>
<td>Choose New Student on File menu</td>
<td>ESC N</td>
</tr>
<tr>
<td>Add a new student</td>
<td>Choose Close Student on File menu</td>
<td>ESC W</td>
</tr>
<tr>
<td>Close a student record</td>
<td>Choose Print on File menu</td>
<td>ESC P</td>
</tr>
<tr>
<td>Print a student record</td>
<td>Choose Quit on File menu</td>
<td>ESC Q</td>
</tr>
<tr>
<td>Leave the Macintosh</td>
<td>Choose Conservatory or Go to menu</td>
<td>ESC K</td>
</tr>
<tr>
<td>Leave and Return</td>
<td>Choose Go to Chapter or Go to menu</td>
<td>ESC G</td>
</tr>
<tr>
<td>Select a Classroom chapter</td>
<td>Choose Restart Lesson or Go to menu</td>
<td>ESC L</td>
</tr>
<tr>
<td>Restart a Conservatory</td>
<td>Choose Ducks on Arcade menu</td>
<td>ESC D</td>
</tr>
<tr>
<td>Play the Shooting Gallery</td>
<td>Choose Ripcord on Arcade menu</td>
<td>ESC R</td>
</tr>
<tr>
<td>Play the arcade game</td>
<td>Choose Atlantis on Arcade menu</td>
<td>ESC A</td>
</tr>
<tr>
<td>Play the Blackjack</td>
<td>Choose Lukealon on Arcade menu</td>
<td>ESC J</td>
</tr>
<tr>
<td>View test scores</td>
<td>Choose Hall of Fame or Administration menu</td>
<td>ESC F</td>
</tr>
<tr>
<td>Go to next Lesson</td>
<td>Choose Next Lesson on Lesson menu</td>
<td>ESC I</td>
</tr>
<tr>
<td>Go to previous Lesson</td>
<td>Choose Previous Lesson on Lesson menu</td>
<td>ESC I</td>
</tr>
</tbody>
</table>